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This study explores the impact of cultural tourism festivals on soft diplomacy outcomes, 

examining how aesthetic appeal, intercultural communication effectiveness, perceived cultural 

authenticity, and cultural engagement influence the destination image and behavioral intentions 

of international tourists. Using a structural equation modeling (PLS-SEM) approach, data were 

collected from 401 international visitors attending cultural festivals in Indonesia. The results 

indicate that aesthetic appeal significantly enhances cultural engagement, positively influencing 

the effectiveness of intercultural communication and perceived cultural authenticity, which are 

key drivers of perceived value. Meanwhile, destination image serves as a mediator in shaping the 

effects of soft diplomacy. The findings underscore the importance of cultural tourism as a non-

coercive tool of diplomacy, demonstrating that well-designed cultural festivals can improve a 

country's international image, foster goodwill, and influence future tourist behaviors. This study 

contributes to the integration of destination branding, intercultural communication, and soft 

power theories, offering a novel framework for understanding the role of cultural tourism in 

international relations. Implications for cultural event organizers and policymakers are discussed, 

highlighting strategies to enhance cultural engagement and leverage soft diplomacy for nation 

branding. 
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Introduction 

Tourism has become a powerful platform for fostering intercultural understanding and enhancing the country's soft power in 

global mobility and cultural interconnectedness. In developing nations, cultural tourism is increasingly leveraged as an 

economic driver and a diplomatic strategy for influencing international perceptions and promoting cultural identity (Beljanski 

& Bukvić, 2020; Gröschl, 2020). Festivals, including traditional performances, heritage festivals, and creative exhibitions, are 

no longer regarded as mere attractions; they function as integrative cultural spaces where immersive experiences generate 

emotional resonance, dialogue, and informal diplomacy. In these settings, the roles of intercultural sensitivity, cultural 

hybridity, and creative engagement are essential in shaping visitor perceptions and fostering mutual respect across cultural 

boundaries (Kipng’etich, 2024; Li & Adnan, 2023). Although significant scholarly attention has been devoted to key tourism 

constructs such as authenticity, aesthetic value, tourist satisfaction, and destination image, few studies have examined how 

these elements operate collectively within the cultural festival framework as tools of soft diplomacy (Morozova, 2023). 

Research tends to explore intercultural communication or emotional experience in isolation, leaving a gap in understanding 

how these constructs interact to influence visitor engagement, perceived value, and behavioral intention toward the host culture 

(Hagqvist et al., 2020; Yuwita, 2023). This requires integrated conceptual frameworks that capture the dynamic relationships 

between these variables within the tourism setting. Theoretically, this study is anchored in three intersecting domains: Soft 

Power Theory (Nye, 2008), which emphasizes the persuasive appeal of cultural expression in diplomacy; Intercultural 

Communication Theory (Gudykunst, 2003; Hall, 1976; Hofstede, 1983), which provides insight into how meaning is 

constructed and interpreted across cultural contexts; and destination branding theory, which explains how cultural experiences 

contribute to the formation of a nation's image and appeal. These perspectives support a multi-dimensional understanding of 

cultural festivals as experiential and symbolic arenas where visitor psychology, national identity, and international perception 

coalesce. Recent literature has increasingly acknowledged the role of cultural diplomacy in shaping global perceptions, 

especially in the context of non-Western and developing countries. While cultural performances can generate admiration and 

elevate the destination's image, they do not always lead to sustained cultural engagement or support for national narratives 

unless deeper emotional and intercultural connections are established (Al Sayegh et al., 2023; Sun, 2024). The lack of 

integrative, empirically grounded models for assessing these outcomes limits academic understanding and practical 

implementation. There remains a pressing need to examine how immersive experiences—such as perceived authenticity, 

intercultural sensitivity, and aesthetic appreciation—translate into long-term behavioral intentions and positive national 

perception (Ertem-Eray, 2023). In response to this gap, the present study proposes a novel framework that links micro-level 
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visitor experiences to macro-level outcomes in cultural diplomacy. By integrating variables such as perceived authenticity, 

aesthetic appeal, intercultural sensitivity, and perceived value while identifying the mediating roles of cultural engagement and 

destination image, this research offers a comprehensive model for understanding how cultural festivals influence international 

audiences. The proposed framework contributes to advancing the theoretical and empirical discourse on cultural tourism, soft 

power, and visitor behavior, particularly in the strategic positioning of cultural festivals within the tourism and public diplomacy 

agendas of developing countries. 

 

Literature review 

Perceived cultural authenticity 

Perceived cultural authenticity refers to tourists' subjective judgments about the genuineness and cultural integrity of festivals 

and performances. Authentic experiences enhance emotional resonance, cultural appreciation, and cognitive engagement 

(Guerra et al., 2022; Stanovčić et al., 2021). Key traditional elements—such as costumes, music, storytelling, and symbols—

anchor this perception, enriching the educational and emotional value of the experience (Mo et al., 2024; Yang et al., 2023). 

Multisensory cues further deepen immersion, fostering stronger psychological connections with cultural narratives (Guo et al., 

2021; Wang et al., 2023). Authenticity also builds trust, positioning visitors not only as observers but as active participants in 

meaningful cultural encounters (Stylidis et al., 2020; Zheng et al., 2022). Authentic experiences are closely linked to existential 

authenticity, leading to personal meaning, satisfaction, and reinforcement of cultural values (Yi et al., 2021; Zhang & Deng, 

2022). When grounded in local narratives and community participation, authenticity boosts perceived value and strengthens 

destination image (Uslu et al., 2023; Zuo et al., 2024). However, over-commercialization may dilute authenticity unless modern 

adaptations respect cultural integrity (Yong-jun et al., 2021; Yang Zhang & Lee, 2021). In sum, perceived authenticity enhances 

visitor experiences and drives behavioral intentions such as revisits and recommendations, supporting its role as a key driver 

of perceived value. 

 

H1: Perceived Cultural Authenticity positively influences Perceived Value. 

 

Intercultural communication effectiveness 

Intercultural communication effectiveness refers to how well cultural messages are conveyed, understood, and interpreted by 

diverse audiences. It involves both verbal and non-verbal cues that bridge linguistic and cultural gaps, allowing performances 

and exhibitions to become emotionally resonant and cognitively accessible (Wei-wei et al., 2021; Yang et al., 2022). Effective 

communication enables cultural expressions to transcend barriers, fostering emotional connection and deeper interpretation 

processing (Seo et al., 2021). Rich, clear messaging—through metaphors, storytelling, and symbolic acts—stimulates curiosity, 

admiration, and appreciation of cultural heritage (Genç & Kozak, 2020; Güney, 2021). Technological enhancements like 

augmented reality can improve communication by adding context and reducing misunderstandings (Kurniati et al., 2020; Wu 

et al., 2024). Closely related is intercultural sensitivity, or the ability to empathize with cultural differences. Visitors high in 

sensitivity are more receptive to local customs and engage more respectfully, fostering emotional bonds and enhancing 

destination perception (Genc & Temizkan, 2023; Guerra et al., 2022). When paired with authenticity, effective communication 

deepens emotional resonance and attachment to place (Liu et al., 2022; Seo et al., 2021), leading to greater satisfaction and 

repeat visitation (Chua et al., 2024; Mok, 2022; Shi et al., 2025). Thus, enhancing intercultural communication effectiveness is 

key to improving perceived value and enriching the cultural tourism experience. 

 

H2: Intercultural Communication Effectiveness positively influences Perceived Value. 

 

Aesthetic appeal 

Aesthetic appeal enhances visitor engagement in cultural festivals by triggering multisensory and emotional responses. 

Elements such as costumes, choreography, stage design, and symbolic motifs work together to create immersive environments 

that evoke curiosity, admiration, and emotional involvement (Folgado-Fernández et al., 2021; Yen, 2022). These expressions 

foster deeper emotional and cognitive connections with cultural narratives, with fashion and design playing a key role in shaping 

the atmosphere and storytelling (Yang et al., 2022). Harmonious and coherent performances also enrich cultural interpretation 

(Şimşek, 2023; Yen, 2022). Beyond immediate sensory impact, aesthetic appeal shapes how experiences are emotionally 

processed and remembered. Emotions like awe, nostalgia, and joy enhance memorability and deepen long-term engagement 

(Hains & Hains, 2021; Hwang et al., 2021). Immersive aesthetics can induce a flow state, facilitating stronger cultural 

appreciation and identity internalization through performance art and symbolism (Genc & Temizkan, 2023). These aesthetic 

encounters not only promote intercultural understanding but also raise the perceived value of the event (Wei-wei et al., 2021; 

T. Zhang et al., 2021). 

 

H3: Aesthetic Appeal positively influences Cultural Engagement. 

 

Cultural engagement 

Cultural engagement refers to the emotional, cognitive, and behavioral involvement visitors experience during cultural tourism 

festivals, often expressed through immersion, reflection, and curiosity (Traversa, 2024; Xiao-li et al., 2020). This engagement 

is fueled by the synergy of authenticity and aesthetic appeal—authentic content fosters personal connection, while aesthetic 
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richness sustains emotional attention (Kluis & Land-Zandstra, 2023). Visitors who connect meaningfully with cultural 

narratives tend to form lasting impressions, report higher satisfaction, and promote the host culture through word-of-mouth or 

revisits (Massari et al., 2022). Interactions with authentic elements, such as original artifacts, heighten enthusiasm and learning 

compared to replicas (Ceylan, 2024; Sun, 2023). Immersive technologies like AR/VR also enhance access and emotional 

resonance, amplifying engagement (Malmisalo-Lensu, 2021; Ning & Chang, 2021). Perceived authenticity strengthens 

emotional involvement, satisfaction, and existential authenticity—a sense of real connection that supports identity formation 

and reflective learning deeply (Baker et al., 2020; Genç & Genc, 2022; Ravichandran & Nam, 2024; Uslu et al., 2023). Deep 

engagement leads to advocacy, conservation support, and higher perceived value, as visitors gain emotional and educational 

enrichment. Aesthetic immersion, storytelling, and culinary experiences enhance understanding of local identity and values 

(Haller et al., 2020; Hiamey et al., 2020). 

 

H4: Cultural Engagement positively influences Perceived Value. 

 

Perceived value 

In cultural tourism, perceived value reflects a visitor's overall assessment of the experience as worth emotionally, educationally, 

and socially relative to their investment of time, money, and attention (Rezaei et al., 2023; Sahabuddin et al., 2021). This value 

is shaped by authenticity, aesthetic appeal, communication, and engagement. Authentic experiences with storytelling and 

immersive traditions enhance emotional satisfaction and attachment (Mo et al., 2024). Aesthetic richness, especially 

multisensory elements, deepens enjoyment and memorability (Guo et al., 2021; Tu et al., 2022). Clear and meaningful 

communication from guides and performers also strengthens value perception by facilitating understanding of cultural 

narratives. Visitor engagement is equally vital emotional and behavioral involvement during festivals leads to more satisfying, 

personally significant experiences (Badal, 2022; Bundzíková & Jánošová, 2021). Engaged tourists are more likely to revisit, 

recommend, and support cultural preservation. Moreover, perceived value is a strong predictor of destination image, acting as 

a bridge between cultural experience and behavioral outcomes (Zhang & Niyomsilp, 2020). High perceived value fosters 

positive impressions, long-term loyalty, and word-of-mouth advocacy (Abror et al., 2021; Yuqing Zhang & Lee, 2022). 

 

H5: Perceived Value positively influences Destination Image. 

 

Intercultural sensitivity 

Intercultural sensitivity is a key competency in cultural tourism, reflecting a visitor's openness, empathy, and adaptability when 

encountering cultural differences. Tourists with high sensitivity are more capable of appreciating diversity, interpreting cultural 

performances empathetically, and forming nuanced understandings of host societies (Kuluşaklı, 2023). This awareness 

enhances communication, deepens engagement, and leads to more favorable evaluations of destinations (Miguel, 2024; Yepes 

et al., 2024). Intercultural sensitivity fosters meaningful connections with local communities and is strongly linked to traits like 

empathy, tolerance, and openness, often developed through frequent cross-cultural interactions (Güner et al., 2021; Toptsi & 

Hajeer, 2023). Visitors with broader intercultural exposure tend to achieve better communication outcomes and report higher 

satisfaction with host cultures (Wongsuban et al., 2024). Beyond personality traits, intercultural sensitivity is cultivated through 

education and experience. Programs like Erasmus or global online learning initiatives build intercultural competence by 

promoting cross-cultural collaboration and awareness (Chan et al., 2021; Niitsu et al., 2022). In tourism, this translates into 

inclusive, respectful behavior and a stronger emotional connection to local culture (Magsanay et al., 2024). Promoting 

intercultural sensitivity also helps reduce ethnocentrism, foster peacebuilding through exchange, and shape the destination's 

image as open and welcoming (Charoensilp, 2024; Oyenuga & Akwen, 2025). 

 

H6: Intercultural Sensitivity positively influences Destination Image. 

 

Destination image 

Destination image refers to the mental representation tourists form of a place, shaped by both cognitive aspects (e.g., 

infrastructure, hospitality) and affective responses (e.g., cultural richness, emotional appeal) (Swati, 2020). A favorable image 

emerges through authentic cultural representation, strong branding, and emotionally engaging experiences (Li & Adnan, 2023; 

Sanggramasari et al., 2023; Susanto et al., 2022, 2024). In the context of cultural diplomacy, destination image acts as a 

mediator, linking tourists' on-site experiences to broader perceptions of national identity and soft power. A strong image evokes 

admiration and curiosity, deepening cultural engagement (Gürsoy et al., 2022). Emotional and cognitive components of 

destination image shape behavioral responses—positive emotional connections, in particular, encourage revisits, advocacy, and 

deeper cultural appreciation (He et al., 2022). User-generated content (UGC) plays a pivotal role, as emotionally resonant travel 

stories often influence others more than factual information (Hagger et al., 2022; Septianto et al., 2020). Strategic cultural 

storytelling and authentic communication enhance the appeal of the destination and amplify its soft diplomacy impact (Brogni 

et al., 2023; Seyfi et al., 2021). 

 

H7: Destination Image has a positive and significant effect on Soft Diplomacy Effect. 
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Soft diplomacy effect 

The soft diplomacy effect refers to the enhancement of a nation's international image and goodwill through non-coercive, 

culturally immersive experiences, particularly within tourism (Khairunnisa, 2024; Zhu et al., 2021). Cultural festivals act as 

strategic platforms for showcasing heritage and shared values, allowing visitors to emotionally connect with the host country 

and appreciate its political and cultural identity (Kunkunrat, 2024). By engaging with authentic performances and symbolic 

narratives, tourists become informal ambassadors who carry positive impressions abroad. These interactions foster empathy, 

mutual understanding, and relational goodwill—key goals of cultural diplomacy (Reyaz & Khan, 2023; Widiyanto & Atiqah, 

2023). Research further shows that culturally engaging and emotionally resonant experiences enhance a country's soft power, 

encouraging revisits, advocacy, and deeper cultural connections (Widiyanto & Atiqah, 2023; Xia, 2024). Soft diplomacy also 

helps dispel stereotypes and promotes international cooperation, especially when diverse cultural forms (e.g., cuisine, arts, film) 

are strategically integrated (Kunkunrat, 2024). Thus, cultural tourism not only strengthens national image but also influences 

future behavior, confirming the hypothesis: 

 

H8: Soft Diplomacy Effect positively influences Behavioral Intention. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 1. Proposed models 

 

Methodology 

This study adopts a quantitative design to examine structural relationships among key constructs in cultural tourism—

specifically, the effects of perceived authenticity, aesthetic appeal, intercultural communication effectiveness, intercultural 

sensitivity, and cultural engagement on perceived value, destination image, and behavioral intention, with soft diplomacy as a 

mediating variable. Partial Least Squares Structural Equation Modeling (PLS-SEM) was used, suitable for theory-building 

research involving multiple latent variables and complex paths (Henseler et al., 2009; Sarstedt et al., 2021). Data were gathered 

using a structured survey distributed both online and offline to international tourists who had direct exposure to Indonesian 

cultural tourism festivals. Offline surveys were conducted at events such as the Yogyakarta Art Festival, Bali Arts Festival, and 

cultural heritage sites in Bandung and Ubud. The online version was shared through international travel forums, social media, 

and email lists targeting those who visited Indonesia within the past year. This hybrid approach aimed to ensure a representative 

and engaged sample. A total of 401 valid responses were collected, exceeding the sample size requirement for PLS-SEM (Hair 

et al., 2019; Wagner & Grimm, 2023). Participants were screened to confirm attendance at least one cultural festival. The 

instrument used multi-item reflective scales adapted from prior validated studies, with items rated on a five-point Likert scale. 

A pre-test with 30 international tourists ensured clarity and cultural relevance. Data analysis followed a two-step procedure: 

first, assessing the measurement model for reliability, convergent validity (AVE > 0.50), and discriminant validity (Fornell-

Larcker criterion and HTMT) (Henseler et al., 2015); and second, evaluating the structural model using SmartPLS 4.0. This 

included analysis of path coefficients, R², effect sizes (f²), and predictive relevance (Q²), with significance assessed via 

bootstrapping (5,000 subsamples). 

 

Results and discussion 

Respondent profile 

The study collected 401 valid responses from international tourists who attended cultural tourism festivals in Indonesia within 

the past year. These included traditional dance events, heritage exhibitions, and ritual ceremonies in Yogyakarta, Bali, and 

Bandung. The sample reflected a diverse demographic, with 55.1% female, 43.4% male, and 1.5% undisclosed. Most 

respondents were aged 25–44 (58.4%), followed by 18–24 (21.7%), 45–54 (13.2%), and 55+ (6.7%). Regionally, tourists came 

primarily from Western Europe (36.9%), North America (21.4%), East and Southeast Asia (18.7%), Oceania (10.2%), and 

other regions (12.8%). A large majority held at least a bachelor's degree (72.1%), with 24.4% having postgraduate 

qualifications. Occupationally, 33.9% were professionals, 20.7% students, 17.2% entrepreneurs/creatives, and 12.5% retirees. 

Cultural tourism was the primary motive for 62.6% of respondents, while 37.4% cited it as a secondary interest. Most (59.1%) 

attended more than one festival. In terms of stay duration, 42.4% stayed 7–14 days, 30.9% over 15 days, and 26.7% less than 
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a week. Repeat visitation was high, with 68.3% having visited Indonesia before. Notably, 77.8% would recommend Indonesian 

cultural festivals, and 70.6% intended to return for future cultural experiences, underscoring the role of cultural tourism in 

promoting soft diplomacy and national image. 

 

Measurement model 

The assessment of the measurement model is a critical step in ensuring that the constructs used in this study are measured with 

sufficient reliability and validity. This study employs a reflective measurement model, in which indicators are assumed to 

reflect the latent constructs. In line with recommendations from (Sarstedt et al., 2021), the model evaluation includes the 

following: 1) indicator reliability via outer loadings, 2) internal consistency reliability via Cronbach's alpha and composite 

reliability (CR), 3) convergent validity via average variance extracted (AVE), and 4) discriminant validity using the Heterotrait-

Monotrait Ratio (HTMT). Each construct in the model was measured using three reflective indicators adapted from prior 

validated instruments in tourism, cultural diplomacy, and cross-cultural communication research. All items were rated on a 5-

point Likert scale ranging from 1 (strongly disagree) to 5 (strongly agree). The results for indicator loadings, Cronbach's alpha, 

CR, and AVE are shown in Table 1. 

 
Table 1. Reflective indicators, loadings, reliability, and convergent validity 

Code Instrument Loading 

AE Aesthetic Appeal (Cronbach α=0.835; CR=0.900; AVE=0.751)  

AE1 The costumes and stage design of the festivals were visually impressive. 0.831 

AE2 The music, dance, and performance elements were aesthetically captivating. 0.902 

AE3 The festivals presented a harmonious and culturally rich artistic expression. 0.865 

BI Behavioral Intention (Cronbach α=0.889; CR=0.931; AVE=0.818)  

BI1 I intend to revisit Indonesia to attend similar cultural festivals in the future. 0.909 

BI2 I would recommend this cultural experience to others. 0.890 

BI3 I am interested in learning more about Indonesian culture after this experience. 0.914 

CE Cultural Engagement (Cronbach α=0.900; CR=0.938; AVE=0.834)  

CE1 I felt emotionally connected during the cultural performance. 0.888 

CE2 I reflected deeply on the cultural meanings during the festivals. 0.933 

CE3 I was fully immersed in the cultural atmosphere throughout the festivals. 0.918 

DI Destination Image (Cronbach α=0.886; CR=0.929; AVE=0.814)  

DI1 The festivals enhanced my perception of Indonesia as a culturally rich country. 0.879 

DI2 I now view Indonesia more positively after attending the festivals. 0.920 

DI3 Indonesia appears more attractive as a travel destination due to its rich cultural heritage. 0.907 

ICE Intercultural Communication Effectiveness (Cronbach α=0.839; CR=0.903; AVE=0.756)  

ICE1 The festivals effectively conveyed their cultural meaning, even across language barriers. 0.862 

ICE2 I understood the intended message or story of the performance. 0.894 

ICE3 Cultural expressions were conveyed in a way that felt accessible to me as a foreign visitor. 0.852 

IS Intercultural Sensitivity (Cronbach α=0.817; CR=0.892; AVE=0.734)  

IS1 I enjoyed interacting with people from different cultural backgrounds during the festivals. 0.845 

IS2 I attempted to comprehend the perspectives and values inherent in the performance. 0.913 

IS3 I appreciated cultural differences during this tourism experience. 0.808 

PCA Perceived Cultural Authenticity (Cronbach α=0.814; CR=0.890; AVE=0.729)  

PCA1 The cultural festivals felt authentic to their roots. 0.826 

PCA2 The performance reflected genuine aspects of local tradition. 0.872 

PCA3 The experience felt culturally meaningful and credible. 0.863 

PV Perceived Value (Cronbach α=0.781; CR=0.871; AVE=0.693)  

PV1 I received valuable cultural insight through these festivals. 0.866 

PV2 The experience was worth the time and money I spent. 0.819 

PV3 Overall, I consider this cultural festival a rewarding experience. 0.811 

SDE Soft Diplomacy Effect (Cronbach α=0.868; CR=0.919; AVE=0.790)  

SDE1 This cultural festival helped improve my perception of Indonesia on a global level. 0.890 

SDE2 I now feel more connected to Indonesia as a country after this experience. 0.879 

SDE3 Festivals like this foster goodwill and mutual understanding between countries. 0.898 

 

All items demonstrated satisfactory factor loadings (≥ 0.80), and internal consistency reliability was confirmed for each 

construct with Cronbach's Alpha values above 0.78 and CR values above 0.87. Furthermore, the AVE values for all constructs 

exceeded the 0.50 threshold, confirming that each construct explains more than 50% of the variance in its indicators, thereby 

meeting the criterion for convergent validity (Fornell & Larcker, 1981). To assess discriminant validity, the Heterotrait-

Monotrait Ratio (HTMT) was calculated. HTMT values below 0.85 indicate strong discriminant validity (Henseler et al., 2015). 

Table 2 presents the HTMT results for all construct pairs. 

 
Table 2. Discriminant validity – Heterotrait-Monotrait ratio (HTMT) 

Constructs BI CE DI ICE IS PCA PV SDE 

Aesthetic Appeal  0.779 0.577 0.444 0.651 0.489 0.653 0.889 0.665 

Behavioral Intention  — 0.520 0.514 0.533 0.488 0.521 0.775 0.825 

Cultural Engagement  — 0.468 0.426 0.765 0.372 0.618 0.549 

Destination Image    — 0.448 0.595 0.295 0.406 0.623 

Intercultural Communication Effectiveness     — 0.368 0.800 0.658 0.547 

Intercultural Sensitivity      — 0.336 0.530 0.623 

Perceived Cultural Authenticity      — 0.703 0.461 

Perceived Value        — 0.627 

 

All HTMT values fall below the conservative threshold of 0.85, providing strong evidence of discriminant validity among 

constructs. The highest inter-construct correlation (HTMT = 0.889) was observed between Aesthetic Appeal and Perceived 

Value, which is theoretically justified given that emotionally compelling and artistically rich performances enhance the 

perceived benefit of cultural experiences. The measurement model demonstrates strong psychometric properties, confirming 

that the structural model's constructs are reliable and valid, thus allowing for a confident interpretation of subsequent structural 

relationships. 
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Structural model 

After validating the measurement model, the next step involved assessing the structural model to evaluate the predictive 

relationships among the latent constructs. This assessment included evaluating the coefficient of determination (R²), predictive 

relevance (Q²), and path coefficients for hypothesis testing. The R² values indicate the proportion of variance in the endogenous 

variables explained by the exogenous variables in the model. According to (Chin & Newsted, 1998), R² values of 0.67, 0.33, 

and 0.19 are considered substantial, moderate, and weak, respectively. As shown in Table 3, the model explains 52.8% of the 

variance in Behavioral Intention, 47.5% in Perceived Value, 30.0% in Soft Diplomacy Effect, 28.0% in Destination Image, and 

25.5% in Cultural Engagement, suggesting moderate to substantial explanatory power across most constructs. The Stone-

Geisser Q² values were calculated using the blindfolding procedure to evaluate predictive relevance. All Q² values for the 

endogenous constructs were above zero, indicating that the model has satisfactory predictive relevance (Sarstedt et al., 2021). 

 
Table 3. R² and Q² 

Construct R² Q²  

Behavioral Intention 0.527 0.426 

Cultural Engagement 0.253 0.210 

Destination Image 0.276 0.222 

Perceived Value 0.471 0.316 

Soft Diplomacy Effect 0.298 0.234 

 

Based on bootstrapping (5,000 samples), Table 4 and Figure 1 present the results of hypothesis testing. All path coefficients 

are statistically significant (p < 0.05), with t-values far exceeding the minimum threshold of 1.96 (for a 95% confidence level), 

providing support for all proposed hypotheses. 

 
Table 4. Hypothesis testing results 

Path β t-value p-value Supported 

H1: Perceived Cultural Authenticity → Perceived Value 0.324 5.138 <0.001 Yes 

H2: Intercultural Communication Eff. → Perceived Value 0.206 3.199 0.001 Yes 

H3: Aesthetic Appeal → Cultural Engagement 0.505 10.615 <0.001 Yes 

H4: Cultural Engagement → Perceived Value 0.342 5.501 <0.001 Yes 

H5: Perceived Value → Destination Image 0.165 3.279 0.001 Yes 

H6: Intercultural Sensitivity → Destination Image 0.437 8.216 <0.001 Yes 

H7: Destination Image → Soft Diplomacy Effect 0.547 13.476 <0.001 Yes 

H8: Soft Diplomacy Effect → Behavioral Intention 0.727 18.888 <0.001 Yes 

 

All eight hypothesized paths are statistically significant and demonstrate meaningful effect sizes. Notably, the strongest path is 

observed from the Soft Diplomacy Effect → Behavioral Intention (β = 0.727, t = 18.888), emphasizing the substantial role of 

soft diplomacy outcomes in shaping international tourists' future behaviors. Similarly, the influence of Destination Image on 

the Soft Diplomacy Effect (β = 0.547) and Aesthetic Appeal on Cultural Engagement (β = 0.505) underscores the importance 

of visual-cultural experiences in building long-term affinity and trust toward the host country. 

 

 
Figure 2. Final structural model 

 

Discussion 

The findings confirm that cultural tourism festivals significantly shape international visitors' perceptions, attitudes, and 

behavioral intentions through pathways involving cultural engagement, perceived value, and destination image. Aesthetic 

appeal showed a strong influence on cultural engagement (β = 0.505, p < 0.001), highlighting the emotional and sensory 

dimensions of cultural experiences (Folgado-Fernández et al., 2021; Yen, 2022). Cultural engagement also predicted perceived 

value (β = 0.342), while intercultural communication effectiveness (β = 0.206) and cultural authenticity (β = 0.324) emerged 

as key antecedents, supporting prior findings on festivals as spaces for value co-creation and informal diplomacy (Kovačić et 

al., 2023; Morozova, 2023). The model confirmed the mediating role of destination image in soft diplomacy. Both perceived 
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value (β = 0.165) and intercultural sensitivity (β = 0.437) shaped destination image, which strongly predicted soft diplomacy 

outcomes (β = 0.547). In turn, soft diplomacy was the most potent predictor of behavioral intention (β = 0.727, p < 0.001), 

aligning with Nye's soft power theory (2008) and emphasizing tourism's potential as a diplomatic tool. The study contributes 

by integrating theories of destination branding, soft power, and intercultural communication within a unified empirical 

framework via PLS-SEM. Unlike previous fragmented studies, it reveals how authenticity, communication, and engagement 

interact to shape long-term visitor behavior and perceptions of national identity (Braslauskas, 2023; Komorowski et al., 2023). 

Positioning soft diplomacy as a mediator is a key theoretical advancement for tourism diplomacy research. Practically, the 

findings urge tourism stakeholders to focus on curating culturally authentic and aesthetically rich experiences, enhancing 

communication (e.g., multilingual storytelling), and promoting intercultural sensitivity. As soft diplomacy strongly predicts 

future engagement, cultural tourism offers a strategic, non-coercive avenue for nation branding, especially relevant for 

emerging or postcolonial nations seeking global visibility through culture. 

 

Conclusions 

This study examined how cultural tourism festivals contribute to soft diplomacy by integrating aesthetic appeal, intercultural 

sensitivity, communication, authenticity, and destination image into a unified model. Drawing on survey data from 401 

international visitors to Indonesian festivals, the model confirmed that perceived value and destination image mediate the 

influence of cultural engagement on behavioral intention. Notably, soft diplomacy emerged as the strongest predictor of future 

tourist behavior, validating the role of cultural festivals as practical tools for informal diplomacy and cultural branding. The 

findings offer empirical support for combining destination branding, intercultural communication, and soft power theories to 

explain cultural tourism's strategic role in shaping national image. The study's generalizability is limited by its focus on 

Indonesia; future research should adopt cross-national comparisons to explore soft power dynamics across regions. The cross-

sectional design also limits insights into long-term effects—longitudinal or experimental approaches are recommended to track 

evolving perceptions. While the model captured mediating effects using reflective constructs, future studies could include 

moderating variables (e.g., nationality, prior exposure) or employ multi-group analysis (MGA) to explore subgroup differences. 

Additionally, reliance on self-reported data may introduce bias; behavioral data (e.g., return visits, online engagement) could 

strengthen future models. Finally, refining the soft diplomacy construct with multi-dimensional and institutional metrics may 

improve its robustness and policy relevance. 
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